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Prerequisites
- Window 7 or newer

- Unreal Game Engine

Compatible: Unreal 4.20 or newer (incl. Unreal Engine 5)
https://www.unrealengine.com

- For projects containing C++ Code: Visual Studio

This is a requirement of Unreal Engine for using it with C++ code.
Blueprint-only projects work without Visual Studio as well.

Compatible: Visual Studio Community 2017 or newer (incl. 2019 & 2022)

https://www.visualstudio.com/en-us/downloads/download-visual-studio-vs.aspx

Select “Desktop development with C++” in the Visual Studio installer.
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Getting Started with the Cyberith SDK in Unreal Engine

This instruction document is covering both Unreal Engine 4 and Unreal Engine 5. While menus may look
different in different versions of Unreal Engine, the concept and the required steps to implement the
Virtualizer remain unchanged!

To get started using the Virtualizer in Unreal Engine, we recommend you to first check the Example Maps
we deliver with our Unreal Engine SDK Package.
To do so you can either use a Blueprint project or a C++ project.

Once you have verified the functionality of the Virtualizer using our Example Map, you can integrate the
Virtualizer in your own project.

Thus, we suggest to follow these steps:

Step 1: Setup Example Project
Option A: Use a Blueprint Template
Option B: Use a C++ Template

Step 2: Setup your Own Project
Option 1: Using the provided BP_VirtPlayer Controller
Option 2: Creating/Modifying your own C++ Player Controller
Option 3: Creating/Modifying your own Blueprint Player Controller
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Step 1 - Setup Example Project

Setting up the Cyberith Virtualizer SDK and the Example Maps in an Unreal Engine (4 or 5) Blueprint or C++
project is done by following steps:

1. Create new empty project

Start the Epic Launcher, click on Library and launch the installed Engine version you want to work with.

@ Epic Games

ENGINE VERSIONS )

4.,22.3
[ Latneh | -

For Unreal Engine 4, create a New Project by selecting the Tab “New Project”, then choose
“Blueprint” (Option A) or “C++” (Option B) and “Blank”. We suggest to select “No Starter Content” (it also
works with Starter Content).

AU Unreal Project Browser

Projects New Project

Choose a template to use as a starting point for your new project. Any of these features can be added later by clicking Add Feature or Content Pack in Content Browser.

8 Blueprint g C++

. ® B
- i 3
First i Handheld nDisplay Puzzle
Person AR
. ‘ - v . R
™ = " | Ve
a % w x i
Rolling Side 20 Side Third Top Down Twin Stick

Scroller Scroller Person Shooter

e %{3 Blank
- €, ™k , o

A rlpan amnty n

rniect with na cnde

Choose some settings for your project. Don't worry, you can change these later in the Target Hardware section of Project Settings. You can also add the Starter Content to your project later

using Content Browser

Desktop / Console Maximum Quality No Starter Content

Select a location for your project to be stored

C:\Unreal -l Blueprint_Example

Folder Name

Create Project
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u Unreal Project Browser

Projects New Project

hoose a template to use as a starting point for your new project. Any of these features can be added later by clicking Add Feature or Content Pack in Content Browser

¥ Blueprint | g C++

= . & =

o

Flying Rolling Side
Person Scroller
) 5 -
2 y S,
» <5
20 Side Third Top Down Stic vehicle Vehicle

Scroller Person S Advanced

Basic Code

An smntv nraiact with «ame hasic name framewnrk rnde rlacess created

e some settings for your project. D y. you can change these later in the Target Hardware section of Project Settings. You also add the Starter Content to your project lat
Content Browser

Desktop / Consol Maximum Quality No Starter Content

ect a location for your project to be store

C:\Unreal - Cpp_Example

Name

Create Project

Choose a project folder and a project name before clicking “Create Project”. Make sure to remember the
selected project folder and name (rootDirectory), as this will be required in the following steps. (The default
installation path is “C:\Users\YourWindowsUserName\Documents\UnrealProjects”.)

To create a new project in Unreal Engine 5, you need click “Games” and then select “Blueprint” on the right.
Select the same settings as described above for UE 4.

—

RECENT PROJECTS

GAMES *

Q{ "
FILM /VID -

LIVE EVENTS

dig
ARCHITECTURE‘
ATONETE

PRODUCT DESIGN &
MANUFACTURING

Create
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You'll have created an empty project now:

> ..
o ) W @ @7 )

Recently Placed
Basic

Lights
Cinematic
Visual Effects
Geometry

Volumes

[T - o +

Level Untited (P
B8 Content Browse
B AddNew~ & impot B SaveAll € % Content »

4 Rendering

Screenshot taken in UE 5
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2. Import the CybSDK Unreal Engine Plugin

Cyberith Virtualizer SDK is distributed as a custom Unreal Engine Plugin. Follow these steps to implement
it:
1. Close Unreal Engine.
2. Extract the CybSDK Plugin folder you downloaded from our developer webpage into the project:
o Unzip the provided .zip folder
o Copy the content of the extracted folder into the rootDirectory of your Unreal Engine
project
o The rootDirectory is the project folder + name created in step 1.
The exact location of the SDK path must be: rootDirectory/Plugins/CybSDK_Plugin
o Example path: C:\Unreal\Blueprint_Example\Plugins\CybSDK_Plugin (Installation Folder:
C:\Unreal; Project Name: “Blueprint_Example”)

O

0OS(C) > Unreal > Blueprint_Example

~

Name Anderungsdatum Typ GroBe
Config 08.05.2020 15:36 Dateiordner
Content 08.05.2020 15:36 Dateiordner
Intermediate 08.05.2020 15:36 Dateiordner
| © Plugins 08.05.2020 15:55 | Dateiordner
Saved 08.05.2020 15:36 Dateiordner
(1] Blueprint_Example.uproject 08.05.2020 15:36 Unreal Engine Proj... 1KB

The above image shows a blank Blueprint project after the CybSDK Plugin was added.

0OS(C) > Unreal >| Blueprint_Example > Plugins > CybSDK_Plugin >I

~

Name Anderungsdatum Typ GroBe
Binaries 08.05.2020 15:55 Dateiordner
Content 08.05.2020 15:55 Dateiordner
Intermediate 08.05.2020 15:55 Dateiordner
Resources 08.05.2020 15:55 Dateiordner
Source 08.05.2020 15:55 Dateiordner
D CybSDK_Plugin.uplugin 07.05.2020 10:14 UPLUGIN-Datei 1KB
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0OS(C) > Unreal > Cpp_Example > v

~

Name Anderungsdatum Typ GroBe
Vs 08.05.2020 16:45 Dateiordner
Binaries 08.05.2020 16:46 Dateiordner
Config 08.05.2020 16:45 Dateiordner
Content 08.05.2020 16:47 Dateiordner
Intermediate 08.05.2020 16:49 Dateiordner
1 Plugins 08.05.2020 16:51 ] Dateiordner
Saved 08.05.2020 16:49 Dateiordner
Source 08.05.2020 16:45 Dateiordner
% Cpp_Examplesin 08.05.2020 16:45 Microsoft Visual St.. 5KB
@ Cpp_Example.uproject 08.05.2020 16:45 Unreal Engine Proj... 1KB

The above image shows a blank C++ project after the CybSDK Plugin was added. Note the “.sIn” Visual
Studio Solution file.

0SS (C) > Unreal JICpp_ExampIe > Plugins > CybSDK_Plugin > I

~

Name Anderungsdatum Typ GroBe
Binaries 08.05.2020 16:51 Dateiordner
Content 08.05.2020 16:51 Dateiordner
Intermediate 08.05.2020 16:51 Dateiordner
Resources 08.05.2020 16:51 Dateiordner
Source 08.05.2020 16:51 Dateiordner
& CybSDK_Plugin.uplugin 07.05.2020 10:14 UPLUGIN-Datei 1KB
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3. Regenerate your Visual Studio Solution (C++ Projects ONLY)

This step is only required for C++ Projects (OptionB as selected in step 1, as laid out above). Skip this step, if
you are using a Blueprint project (OptionA).

Right-click the .uproject file in your rootDirectory. In the pop-up menu, click “Generate Visual Studio project
files”.

0OS (C:) > Unreal >JCpp_Example v QO | "Cpp_Exampl

Name Anderungsdatum Typ GroBe

'S 08.05.2020 16:45 Dateiordner

Binaries 08.05.2020 16:46 Dateiordner

Config 08.05.2020 16:45 Dateiordner

Content 08.05.2020 16:47 Dateiordner

Intermediate 08.05.2020 16:49 Dateiordner

Plugins 08.05.2020 16:51 Dateiordner

Saved 08.05.2020 16:49 Dateiordner

Open

Source 08.05.2020 16:45 Dateiordner
s ) ) @ Launch game
s Cpp_Example.sin 08.05.2020 16:45 Microsoft Visual St...

@ Generate Visual Studio project files

I@ Cpp_Example.uproject 08.05.2020 16:45 I Unreal Engine Proj...

@ Switch Unreal Engine version...
© Mit Skype teilen
Zum Startmeni hinzufigen

@ Auf OneDrive verschieben

This step is required for Visual Studio and Unreal Engine to recognize the newly added C++ code.
After your project files have been generated (windows below), there is no specific confirmation of success.

( Unreal Engine e

Generating project files... Show log

As long as there is no Error Massage, everything is normal.
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4. Activate Plugin and Open Example Map

The CybSDK comes with a prebuilt example scene to demonstrate the packages capabilities:

e Reopen your project. Then, click on “Settings” and “Plugins” to open the Plugins window in UE 4.

In UE 5, you need to click “Edit” and “Plugins” to do the same.

(1'! v H ’]
- ¥ ¥ - .
VR Mode Build Launch
Recently Placed

} Basic

‘ oo @)@ = (2 1)
Lights A npty ter

Cinematic

S | Empty Pav Open the Plugins Browser tab.
Visual Effects on

Geometry
Volumes

Al Classes

4World

B Add/import~ [ Save All % Content »

s

£ Type here to search sy T

File Edit Window Tools Build lect Actor

£) Undo History

%, Editor Preferences...

" Project Settings...
+ * Plugins

Virtualizer Unreal SDK Documentation 12



In the Plugins window, search for the “Project” Plugins. In the section “Virtual Reality”, you will
find the Cyberith Virtualizer SDK.

Check the checkbox to enable it. Then, a pop-up massage will appear telling you that a restart is
required. Click “Restart now”.

1"' 2 Flisjirss
1oy E T » Virtual Reality
Mobile Moy Cyberith Virtualizer SDK Version 4.4
Movie Capture I y L The Virtual DK plugin to simplify the integration of Cyberith Virtualiz s into your applications
Movie Players
Networking
- NDTVITICHTIDHVS W  HEnabled Edi ge Support [0 Documentation @ Cyberith GmbH
i= Online Platform
"= Other
'i= Performance
Photography
Physics
PostSplashScreen
PreLoadScreenMoviePlay:
Programming

"= Rendering

Source Control
Testing
Text
Virtual Production
Virtual Reality

"= Water

= Web

*i= Widgets

4@ Project 1 1 Unreal Editor must be restarted for the plugin changes to take effect

File Edit  Window T Help
(A1)

¥ plugins

+ Add Q {:} Settin
Project > Virtual Reality
®: ALL PLUGINS
Version 4.4
PROJECT The Virtualizer SDK plugin to simplify the integration of Cyberith Virtualizer Cyberith GmbH
devices into your applicatior
Virtual Realit: . .
2/ # Edit (' Package & Documentation ’Suppon

INSTALLED

BUILT-IN

& You must restart Unreal Editor for your changes to take effect. Restart Now
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After the restart, close the Plugins window and add your Plugin content to the content browser:
In UE 4:

o Click on View Options in the bottom of the Unreal Editor
o Make sure the checkbox “Show Plugin Content” is checked

delp

em a

Ve :
CrEOE B G IOk

Recently Placed -
[ osi e
Lights

Cinematic

Visual Effects

Geometry

Volumes

All Classes

-10485750

CET— - o

Leyel U
& Coriter

B AddNew's| & impot [SaveAll € |2 Content » 4 [

Show plugin content in the view?

¥ vries - |

00000 S
ity

gu,'n,».g

Launch

o)) @ )@ o) » e

Visual Effects
Geometry
Volumes

All Classes

& Content Browss!

W AddNew~> L impot [ SaveAll & % Content »

Show o hide the sources panel
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In UE 5:

o Open your “Content Drawler”, by clicking on the according button in the bottom left
o Click “Settings” in the top right of the “Content Drawler” window
o Make sure the checkbox “Show Plugin Content” is checked

+ Add ¥ Import > Content

Favorites

MyProject

All
Content

Collections ® Q 0 items

5 Content Drawer Opens a temporary content browser above this status which will dismiss when it loses focus (Ctrl+Space Bar)

Type

Tiles
List
Columns

Lock Content Browser

Show Folders

Show Empty Folders
Show Favorites

Filter Recursively

Show All Folder

Organize Folders

Path View Filters

Show Sources Panel
Show C++ Classes % settings
Show Developers Content
Show Engine Content
Show Plugin Content

Show Localizec |G plugin conte the view?

Search Asset Class Names
Search Asset Path
Search Collection Names

Thumbnail Size
Thumbnail Edit Mode

Raal_Tima Thiimhnaile
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Open “Cyberith Virtualizer SDK Content”, click “Example”, choose “Sample A_Components”, then
“Maps” and open the map “SampleA _Components”. This map is pre-configured, you should be
able to start it and get a first impression of the Cyberith Virtualizer SDK.

-+ Add V] Import

Favorites

MyProject

Con
Plugir
Cyberith

Collections

CEED 6 © (b (b & @ 0

Sample A highlights our custom PlayerController called “BP_VirtPlayerController” which should handle
everything on its own.

The Player Controller in Sample A should serve as an easy start for having VR movement implemented right
out of the box.
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e Alternatively, the other option is “SampleB_BlueprintNodes”. It showcases the movement
behaviour demonstrated with the blueprint system (visual programming) of Unreal Engine.

You can find the corresponding map in the “Maps” subfolder, similarly to Sample A.
However, in SampleB, you can see how we did set up movement controlled by the Virtualizer using
Blueprint by checking the CybSamplePlayerController blueprint.

+ Add V] Import

Favorites

MyProject

Y LELNIL VINLUdILED DU LUTTEENL

Controller

Il Share -
rith Virtual

Collections

Edit A View Debug Window Tools Help
CybSamplePlayerCon... * X

BoBrowse =g Diff v 3 Find H etting Class Defaults ula H No debug obje:

Components X - vport # Details x

+ Add Q n > Q

&4 CybSamplePlayerController (S Defaut

'm Component (Tra

Actor Tick

M My Blueprint x

+Add Q

GRAPHS

by entGraph
Player Controller

& Event End Play : : ; = : = .
: F AP ion R ... b ® X
& Event Tick - ICIBO

FUNCTIONS

MACROS
End Virtualizer ha

VARIABLES = : cheattav @& BB @ X

Mouse Interface

EVENT DISPATCHERS

tent Drawer [ Output Log BEcmd v @ source Control Off

SampleB should help you in case you need to implement the Virtualizer into your own custom Player
Controller via Blueprint. In case there is no such need, we strongly recommend to use the Player Controller
provided by us, like in SampleA.
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5. Start your Virtualizer Experience

Check if your Virtualizer’s USB is plugged.

If it is plugged, you can run the Example Maps (SampleA and also SampleB) and test their functionality with
your Virtualizer.

Please select the VR Preview launch option in the drop-down-menu and have fun.

. q.

Play Launch

v

v P> Selected Viewport (PIE)

ile Preview (PIE)

New Editor Window (PIE)

andalone Game

P Simulate

Please check two points:

e The Locomotion: Walk on your Virtualizer to see your character moving accordingly. This is
implemented in both SampleA & SampleB.

e The Haptic (for SampleA): Walk to the green elevator. When the elevator moves up or down, you
should feel Vibrations coming from the Virtualizer baseplate. This is implemented in SampleA only!

If you run into any problems with the steps above feel free to contact us: support@cyberith.com
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Step 2: Setup Your Own Project — common to all options

Setting up the CybSDK Plugin with your own project, works equivalently to setting it up with the example
maps as laid out in Step 1:

1. Navigate to your project’s root folder
2. Import the CybSDK Plugin by extracting the provided folder in your project’s root folder

3. If your project is a C++ project:
Regenerate your Visual Studio Project Files by right-clicking on the “.uproject” file of your
own project (not required for Blueprint projects)

4. Open your own project in Unreal Engine
After repeating the instructions of Step 1 for your own project, the CybSDK should be visible in your own

project.

ot

ntitlzd (Farsistant)

 Content Browse!

hAddNew» X Import X SaveAll & % Content »

.
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Step 2a: Setup Your Own Project — Option 1: Using the
BP_VirtPlayerController (like in SampleA)

To activate the Virtualizer in your own project using the BP_VirtPlayerController (like in SampleA), one
more step is required:

e Open the World Settings:
o In UE 4 you need to click on Settings/World Settings
o In UE 5 you need to click on Window/World Settings

o —
S . N .3 . o]
g - = B BEIEDE
T s €1
Recently Placed ety

Basic

Lights

Cinematic
Visual Effects
Geometry
Volumes

All Classes

it (Farsistant)
% Content Browser

b AddNew~ & Impot [ SaveAll € % Content »
es

= CybSDK_Plugin Content
& CybSDK_Plugin C++ Classes

4 Precomputed

e In the World Settings menu, select the game mode “BP_VirtGameMode” from the drop-down
menu “GameMode Overide” in the section “GameMode”:

2 Details @ World Settings

He-
4 World
Enable World Co .

Use Client Side .

Kill Z -1048575,0 N\
v
4 Game Mode

P LR BP_VirtGameMode v [£ JNOR- U

D Selected Game

4 Lightmass

D Lightmass Setti

4 Physics
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Now, make sure your Virtualizer is plugged

Press “Play” and check if you can walk in your VR project using the Virtualizer

Please read the documentation below for further information on the Virtualizer's locomotion
functions and the Haptic Feedback
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Step 2b: Setup Your Own Project — Option 2: Creating/Modifying your
own C++ Player Controller (only for C++ projects)

o Start by creating a new C++ class of the type “Player Controller”:

W5 Content Browser X

-+ Add 3 Import & Save All m Al > C++

Favorites
MyProjectCpp
= All

& Content

&’ New C++ Class..
rith Virtualizer

rith Virty $ S Create a new class in /Classes_Game.

Collections ® Q  item

u

CHOOSE PARENT CLASS

Common Classes

This will add a C++ header and source code file to your game project

esponsible for managing the camera for a particular player
sible for controlling a P:

ines the game being played, its r. ing, and other facets of the game type.

Cancel

Adding code to project...

° For exemplary C++ code, please view the “Example usage” of Locomotion in the last chapter of
this document. > follow link to chapter (click here)

o For further details, please check out the Doxygen Documentation for C++ available in our
Developer Center at “developer.cyberith.com” (in the Section “Downloads / SDK”).

Virtualizer Unreal SDK Documentation 22



Step 2c: Setup Your Own Project — Option 3: Creating/Modifying your
own Blueprint Player Controller

In the case that you don’t want to use our standard character controller (and don’t want to create custom
C++ code), for example if you already use your own character controller or other logic limitations would
block you, we also offer an alternative way to use the Virtualizer’s data via Blueprints.

e You can start by creating a Blueprint variable of the type “Virtualizer Device”

Go to your desired component/actor blueprint.

On the right of the “Variables” dropdown view, you will see a small “+” where you will be able to type in
the search view “Virt Device”. Click on it to add the variable.

m My Blueprint

D m= EventGraph
D Functions (;
Macros

4Variables

T Details

U Components

[ Hit Actor

[ Contextual Menu
[ State
b
b
[

4 Variable

Variable Name Virtualizer Device
Laser

Avatar
World Scale

MouseCursorPositionLocked

Variable Type oVil‘t Device v

Instance Editable

Blueprint Read Only

PlayerController on Spawin
Gamelnstance
(1T to Cinematics
22z PlayerindexArray
Category Default

= IndexEmpty
Replication

Replication Condition

IndexFound

4Event Dispatchers
% PawnDestroyed
% ContextualMenuShowing
% MouselLeftPressed

Virtualizer Unreal SDK Documentation 23



e Setup a node logic

A particularly good starting point is to check the blueprint of CybSamplePlayerController from
SampleB_BlueprintNodes and eventually to copy/paste its logic in your own blueprint.

This section explains how this blueprint is set up. It shall serve as an example for you to set up your own.

5 ( File Edit T View Debug Window  Tools  Help

SampleB_BlueprintNod CybSamplePlayerCon...  x
ompile : M Save EG Browse =g Diff v fDFind  *g HideUnrelated } 0} gs s Defaults P Simulation > E CybSamplePlayerController (spawned) ~
Components X = Viewport I struction S... %= Event Graph 7 Details
+ Add Q A~ >
&4 CybSampleP

Transform Component (Tra

C(Oplinnal) Find attached nharact@piianal) Find attached Character Movement Compunenl)

et P s s

= ik 2 (Apply Movement to CharacterMovementComponent
! e— .____-*
M My Blueprint (Handle Multipiayer Ccheck moveﬂﬁind’(ﬁ)ﬁlﬂimualizer device & Open it) = o

(Slup input if sj g_edris/close/equal .- lih‘—?"’

-+ Add Q it sapine e s

H#Eply Movement to Pawn

lay

FUNCTIONS

~*f ConstructionScript

MACROS

VARIABLES

Components
Charact >
Virt D
Characti >
Float et

EVENT DISPATCHERS

5 Content Drawer B Output Log Cmd v @ Source Control
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&> Event Tick

What does this blueprint do?
On the top left, you will find the “Tick” node.
From the Tick which is the “every frame update” call:

v

- First part of the sequence is “finding components”

C(Optional) Find attached character)

(Optional) Find attached character;

o Wetry to find an attached “Character” component & register it in the “PlayerCharacter” variable
of this blueprint.

(Optional) Find attached character,

Self

F Get My Player Index

Player Character

f Get Player Character

o We then try to find an attached “CharacterMovement” component & register it in the
“PlayerCharacterMovement” variable of this blueprint.

(Optional) Find attached Character Movement Component

Player Character Target Character Movement

SET

Player Character Movement Component
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Second part of the sequence is updating the player, rotating it & moving it.

Handle Multiplayer

Handle Multiplayer

7 Was Authority 7 15 Local Player Controller

o  We first check if we are the owner of the PlayerController.

Handle Multiplayer

F Has Authority F Is Local Player Controller

Target Return Value Target [self]  ReturnValue

PR——
T Branch <L Branch
» B True B

Condition False D> Condition False D

Check movement comg

Check movement col

F Get Controlled Pawn

o We then check the presence of a pawn possessed by our PlayerController

Check movement component

JF Get Controlled Pawn .

Target [self] ~ Return Value

2 Is Valid

P Exec Is Valid

Input Object 1s Not Valid >

Virtualizer Unreal SDK Documentation
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o Nextin our logic, we get the plugin managed Virtualizer device & “open it” (ask data access to the
Virtualizer) if it is not opened.
As a reminder, please do not forget that only one program can access Virtualizer data at any time!

Find/Create Virtualizer device & Open it

F Is Open

—

Virtualizer Device
Target Return Value

— -
?'1Is Valid I-ii Branch
P Exec Isvalidfp — ——— True P

Input Object Is Not Valid [ Condition False [p >
e

J Open

f Get Plugin Managed Device < » (D]

=

Return Value

Target Return Value

D

Virtualizer Device

o We then prevent slow movement on the device to make us move while we shouldn’t, customize
the behaviour as you see fit.

Stop input if speed is
close/equal to 0

True

Condition False [
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And the node finishes by applying movement input to the CharacterMovement component or
directly to the possessed Pawn depending on the possessed pawn components.

o

%2 Event Graph

Apply Movement to Pawn

Apply Movement to Pawn

o This means that we have calculated the movement input before.
o We start by getting the Virtualizer Device variable we got earlier.
= First, we get the Player Orientation data (which is between 0 & 1).
= Let’s multiply it by 360 to have an orientation ranging between 0° and 360°.
= Then, get the Controlled Pawn’s Forward direction vector.
= This direction will then be rotated by the player rotation, to get the “Virtualizer” forward
direction, relative to player’s current rotation.
IGEtipawnIbase rotation R B Betite rotationusing the VirtualiZerring

Virtualizer Device

"F Get Player Orientation

Target Return Value

"F Get Controlled Pawn I
J Rotate Vector Around Axis
Targ ] RetumValue Return Value @

"7 Get Actor Rotation

(o0 v [o9) 2[1)

Target Return Value @ =
J Rotation From X Vector

7 Get Forward Vector (
@ InVec Return Value @

< @ InRot Return Value @
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o  We then continue by
= Getting the Virtualizer’s movement direction vector.
> |s the player walking forward in the Virtualizer? Backward?
= Scale it by the estimated Virtualizer's Movement Speed (meter / seconds).
> |s the player walking fast? Slow?
= Get the forward & right vector of the previously calculated rotation, scale it by the
movement vector & make it thus a world oriented movement vector scaled with speed.

Usethatrotation|giscaleitusing theMovementdirection Vectorg speed

f G vement Direction Vector

Return Value @

F Get Movement Speed

=
Add pin ®
F Get Right Vector

Rety

o (Optional) It’s also possible to scale this movement by a custom factor through an easy to modify
blueprint variable.

Varniable = Movement
Scaler

Moveme d Factor

To finish this whole topic, we can also notice that in our CybSamplePlayer, we added a call to force the VR headset

tracking “Origin” to be located on the floor (as normally you have setup your Virtualizer to be calibrated with your
VR headset this way).

This is how you do it. VR Headset - Tracking Origin

&> Event BeginPlay * Set Tracking Origin

Origin
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Note: In order to avoid potential problems caused by sending contradicting commands to the Virtualizer,
a Virtualizer can only have one open connection at a time!

This means that it can also only connect to one Character Controller / Actor within Unreal Engine!

Tip: In case you can’t open a connection to your Virtualizer, check if you have multiple Character
Controllers activated during runtime of your application! You may spawn (an additional?) Character
Controller when you are launching the application by pressing the “Play” Button.

In case there are two Character Controllers active during runtime, only one of them will connect to the
Virtualizer.

= World Outliner

L

F S

Label Type
%¥ Light Source
ParticleEventManager
Player Start
PlayerCameraManager
PlayerController
PlayerState
Sky Sphere
» SkyLight

#. SphereReflectionCapture
*# TestCharacter

o ©, TescChare

22 actors (1 selected)

If there are two Actors that both try to open a connection to the Virtualizer (at runtime), only one of
them will be able to open the connection successfully.

Virtualizer Unreal SDK Documentation 30



No Virtualizer Hardware? — No Problem!

You may want to create applications for the Cyberith Virtualizer without having access to a real hardware
device.
For this purpose, we added two kinds of virtual devices emulating a Virtualizer:

e Keyboard — WASD for movement and QE for rotation
e Controller (Xbox 360 & Xbox One Controller) — left joystick for movement and right joystick for
rotation. Please plug the Xbox Controller to your PC per USB cable to ensure proper functionality.

This means:
If you don’t have a Virtualizer available you can still test the functionality of your implementation with the
help of an Xbox Controller or with the help of your keyboard!

In case no Virtualizer is plugged, the system will automatically use the Xbox Controller. If neither a
Virtualizer nor an Xbox Controller are plugged, the system will automatically use the keyboard.
Alternatively to the automatic selection, these inputs methods can be configured in the project settings. —
as described in the next chapter.

Note:

e Be aware, that these settings will still be active in a built executable and allow to test the finished
(built) application without the need of real Virtualizer hardware.

e Currently, you can not walk backwards with an Xbox Controller. If you press the left joystick back,
the avatar still walks forwards. That does not mean that you can’t walk back with the Virtualizer! It
is a problem caused by the Xbox controller implementation.

e The Xbox Controller allows you to basically check on the functionality of the haptic feedback
(although it can only rumble with one frequency and not in many different ones like the Virtualizer.)
The keyboard input does not allow you to check on the haptic feedback functionality.

e For development and testing purposes it can be practical to use an Xbox Controller even if you
have a real Virtualizer next to you. Using such a controller, you don’t need to stand up from your
comfortable chair for every single test ;)
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The main settings for the Virtualizer are available in your projects settings in the Plugins section.
Click Settings (in UE 4) or Edit (in UE 5), then click Project Settings. Scroll down to the section Plugins and
click on CybSDK to find the following settings:

Virtualizer

Device Type selection to switch between real
Plugins - CybSDK Hardware or emulated debug devices.

fa Th i LS el W e = Cikreony v el ger Decoupling Type selection to test coupled and
decoupled behavior.

4 Virtualizer

[Automatic] -
[Automatic] -
Virtualizer Haptic System (Emitters & Listeners) =

Source selection for the Virtualizers haptic
feedback unit.

Unused due to absolute tracking.
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All of the following settings can be found through the Content Browser of Unreal Engine.

5 Content Browser x

~+ Add Yimport  |=

Favorites

TestProject1

Collections

Click Cyberith Virtualizer SDK Content and then CybSDK in order to see the following components:

BP_VirtPawn

The BP_VirtPawn is a Pawn object, derived from the Unreal Character class. This pawn is moved around
when the user walks in the Virtualizer. It also handles the haptic feedback of the Virtualizer. The
BP_VirtPawn is used in the ExampleMap. The VirtPawn is selected in the BP_VirtGameMode described
later and is spawned at the Player Start position when the ExampleMap is started.

. BP_VirtP |
All the inherited objects and the VROrigin (including _ rtPawn(sef)

the Camera) are Unreal components responsible for iR IR
movement and visualization in Unreal R, ArrowComponent (Inherited)

1 Mesh (Inherited)
4%, VROrigin
- Camera
The other Blueprints are provided by Cyberith and & BP_FallimpactHapticEmitter
handle the haptic of the Virtualizer. #®, BEF_WalkAgainstColliderHapticEmitter

#®, EP_PlayerHitHapticEmitter

“ § CharacterMovement (Inherited)
If you want to deactivate certain HapticEmitter @, BP_VirtHapticListenerComponent
Blueprints, you have to select the specific
HapticEmitter Blueprint and unselect the “Auto
Activate” parameter in the Activation property in the
details view.
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BP_VirtGameMode

The CybSDK defines its own GameMode to define the default Blueprint classes to be spawned.

Overriding the default PlayerController to move
: the pawn according to the Virtualizer input.

e 5
GameStateBase v o “EE @)

Player Controller Class = 0O 4+ 2
Player State Class = D <+
HUD Class [ ¢« 0 + x
Default Pawn Class € D + X -
.o+

Replay Spectator Player Controlle [REWVERRS A S N O g

Server Stat Replicator Class ServerStatReplicator « @

Overriding the default Pawn which bundles all
major features in one.

BP_VirtPlayerController

This script moves the pawn according to the Virtualizer input, as described in the Example Usage.

Movement Speed Multiplier, to fine tune the
players speed. Recommended setting: appx. 1.2
4 Virtualizer

Player speed multiplier
Reference to a SceneComponent that will be
rotated according to the player’s orientation in
the device. If not set will search for
"ForwardDirection" attached to pawn.

Player Forward Directicn
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BP_VirtHapticListenerComponent

This script receives haptic feedback emitted by all active HapticEmitters in range and activates the
Virtualizers haptic vibration unit.

4 Virtualizer

Maximum range for Haptic Emitters to be

Maximum Range “heard” from.

The Haptic Listener sends two parameters for the haptic unit. One of these two parameters is the
frequency, the haptic unit vibrates with. The other parameter is the volume (= “strength”) the haptic unit
vibrates with.

As the resonance frequency of implemented haptic unit is around 40 Hz, the Haptic Listener does not send
out frequencies from 35 to 45 Hz. This avoids loud and uncomfortable vibrations. Instead of sending
frequencies of 35-39 Hz it sends 34 Hz and instead of sending frequencies of 40-45 Hz it sends the
frequency of 46 Hz. You might notice this behavior if you select one of these frequencies in a haptic emitter,
which is explained in the next chapter.

In case multiple Haptic Emitters are active and within range, the HapticListener makes a weighted average
of all the frequencies and sums up the volume caused by all Emitters. The volume of an emitter is defined
by two curves (“Volume Over Time” & “Force over Distance”) for each Emitter individually. Note, that the
overall strength of the vibration can not exceed the maximum strength, independently of how many
emitters you add.
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BP_VirtHapticEmitterComponent

This script emits signals causing haptic feedback in a specific radius around it. These signals are received
by a HapticListener, which in turn causes the Virtualizer baseplate to vibrate.

Attach such a Haptic Emitter to objects, that you want to cause haptic feedback!

Add a Haptic Emitter by:

e Select an object you want to cause vibrations.
e Select the Haptic Emitter you want to use (f.ex. “BP_VirtHapticEmitterComponent”)

e Add the Haptic Emitter to the object by Drag & Drop.

o 2o )@ )@ =)s )

%
(7

WAGINEWS! & impot [ Save All € 5 | B CybSDK_Plugin Content » CybSDK »

RRRTRE | T &

1 Details # World Settings

5 i

4+ Add Component - o, Blueprint/Add Script

i¥ Cylinder(Instance)

somponent (Inherited)

Virtualizer Unreal SDK Documentation 36




Once added, you will see this Haptic Emitter Script:

Reference to the Haptic Listener receiving Haptic
Feedback. If not set will find one in scene

Automatically start playing on application
- - startup. startup. Check this box, if you want an
4 Virtualizer object to cause vibrations whenever the player
comes close to it. Otherwise, you need to activate
it separately by calling the Play method of this
class. To deactivate the Emitter, call the Stop
Loop method. The Play and the Stop method are
Timespan : explained below.

tart Playing

Range
. Loop the haptic feedback over time.
requency

— Duration in seconds for the feedback.
ConstiEurve

Volume over Time

V= D |

Max range of the haptic effects.

Canstoune Frequency for the haptic unit. Range: 10-80Hz.
orce over Distance -~ - The Haptic Listener filters frequencies between

e o= 35-45Hz and sets it to 34 or 46 Hz. Keep that in
mind when choosing frequencies.

FloatCurve for the Haptic force over time.
Normalized [y = force factor, X = time in s]

FloatCurve for the Haptic force over distance to
the Haptic Listener.
Normalized [y = force factor, x = distance in m]

The generic Haptic Emitter “BP_VirtHapticEmitterComponent” Blueprint is the base Blueprint for causing
haptic feedback. You can either activate the haptic functionality by ticking the “AutoStart Playing” checkbox
or call the Play() and Stop() method of the Blueprint (the functionality is implemented in C++, but there are
callable Blueprint methods) to manually activate and deactivate the haptic emitter whenever you like to
do so.

Additionally to the generic Haptic Emitter Blueprint we added four specific Haptic Emitter Blueprints for
special use cases.

In these specific Haptic Emitter Blueprints you can see the Play and Stop methods in action. Check out the
Blueprints and you can see examples of how these methods are used.
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Specific Haptic Emitter Scripts

The following specific Haptic Emitter Blueprints are part of Cyberith’s Unreal Plugin to demonstrate
exemplary use cases of haptic feedback. Feel free to add your own specific Haptic Emitter Blueprints for
whatever purposes you like.

e BP_FalllmpactHapticEmitter: Haptic is triggered when the player lands on the floor after
falling/jumping from higher ground. The player has to fall for more than 0.1 seconds to activate
the haptic feedback once reaching the ground. This Blueprint is attached to the BP_VirtPawn.

e BP_MovementTriggeredHapticEmitter: Haptic is triggered when the object, this Blueprint is
attached to, moves. This Blueprint is attached to the Elevator object in the ExampleMap.

e BP_PlayerHitHapticEmitter: Haptic is triggered when the player is hit by an object. The object
hitting the player has to trigger the PlayerHit Event of this Blueprint. This Blueprint is attached to
the BP_VirtPawn. Furthermore, bullets (looking like big white balls) are spawned during runtime
from the red canon (consisting of a cube and a cylinder). The bullets trigger the PlayerHit Event to
cause haptic feedback upon hitting the BP_VirtPawn.

e BP_WalkAgainstColliderHapticEmitter: Haptic is triggered when the player walks against an
obstacle. The haptic is activated when the player walks against the obstacle for more than 0.5
seconds. This Blueprint is attached to the BP_VirtPawn.

If one of these Blueprints is added to an object in a scene, the generic Haptic Emitter Blueprint
(“BP_VirtHapticEmitterComponent”) shall not be used. The described specific Haptic Emitters work
autonomously.

The “AutoStart Playing” checkbox is not available on any of these scripts. These emitters use the Play and
Stop methods of the Haptic Emitter Blueprint.
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The native CybSDK handles two functionalities differently compared to the standard functions of Unreal
Engine.

In order to ease the process of implementing the Virtualizer into pre-existing systems, we added two “UE
compatibility modes” in order to match the standard functions of Unreal Engine:

Gamepad Axis Emulation

Using this functionality, the Virtualizer device emulates standard GamePad Axis input for better
compatibility with existing Playerinput Systems.

This settings can be configured in Settings -> Project Setting -> Engine -> Input.

1'{ " Project Setings:

Project Engine - Input

s currently writable.

b Shift [l Ctrl

I Keyboard
[ Mouse

ermanently Including Initial Mouse Down v
[ Steam

[ XBox One
4 Mob |,

I DefaultVirtual Joysticks

B *+P°

4 Virty

erith Virtualizer - M War Move Forward == Left Joystick Up
el i'[h ‘|".l'i|"[|_|;_:||iEEI' - r',f-1- P 1 Move nght == Left JOyStICk nght
berith Virtualizer - Absolute Orientation Absolute Orientation == Right Joystick result
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Force Feedback Input

The Virtualizer is fully compatible with the UE4 Force Feedback System for haptic feedback. We created
this mode for better compatibility with existing Playerlnput Systems.
This mode can be activated in Settings -> Project Settings -> Plugins -> CybSDK

u "8 FIojectSettinge

- T - < -

Android Material Quality - Vulkan
Android SDK Plugins - CybSDK

HTML5S

Export._ i import._|

&a These settings are saved in Defaultinput.ini, which is currently writable

108

10S Material Quality

Linux 4 Virtualizer

Ma Device Type

eap Decoupling Override [Automatic] =

Magic Leap SDK Haptics Source System Virtualizer Haptic System (Emitters & Listeners) v

Windows Calibrate oh Zodnect No haptic e
: ‘ - Virtualizer Haptic System (Emitters & Listeners) |

UE4 Force Feedback System

s
AVF Media
MG Media
Level Sequencer
Magic Leap Emulator
Magic Leap Plugin
OculusVR
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All functionalities and classes provided by the CybSDK Plugin are available in Blueprint.

UVirt

This UBlueprintFunctionLibrary exports static functions into blueprint.

GetSDKVersion

Returns: int
Returns the version number of the Virtualizer SDK.

GetPluginManagedDevice

Returns: UVirtDevice*
Gets the Virtualizer device object currently managed by the CybSDK Plugin.

Sample — Haptic Emitter

& Parent: Begin Play
»

[ GetWorldLocation

urrentandiold)

> Event Tick

M

 GetWorldLocation

€ Event End Play
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SDK Documentation

C++ SDK Documentation

For full documentation of the C++ SDK take a look into the official online Documentation.

All classes and functions are documented in their respective header file located in the Include directory
and should show up in your Visual Studio IntelliSense

FCybSDK_PluginModule

This class manages the main CybSDK plugin functionalities.

GetVirtualizerInputDevice

Returns: TSharedPtr<FVirtInputDevice>
Returns the UnrealEngine lInputDevice device managed by the FCybSDK_PluginModule.

FVirtinputDevice

This class has full authority over the Virtualizer device. Here the device is selected, a connection
established and managed.

GetDevice

Returns: TWeakObjectPtr<UVirtDevice>
Returns the Virtualizer device managed by the FVirtinputDevice.

IsDecoupled

Returns: bool
Returns true if the UVirtDevice supports decoupled movement, otherwise false.
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UVirtDevice

This blueprintable wrapper class holds the native Virtualizer Device and supports multiple Unreal specific
methods.

GetMovementVector

Returns: FVector
Returns the movement direction as a speed scaled vector relative to the current player orientation.

GetMovementDirectionVector

Returns: FVector
Returns the movement direction as vector relative to the current player orientation.

GetPlayerOrientationVector

Returns: FVector
Returns the orientation of the player as vector.

GetPlayerOrientationQuaternion

Returns: FQuat
Returns the orientation of the player as quaternion.

UVirtHapticEmitterComponent

Play
Start playing the Haptic Emitter by adding it to the Haptic Listener

Stop

Stop playing the Haptic Emitter by removing it from the Haptic Listener

CYBERITH Virtualizer Unreal SDK Documentation 43



Locomotion

AVirtPlayerController: :Tick( DeltaSeconds)

Super::Tick(DeltaSeconds);

if (!IsLocalPlayerController())
return;

APawn* pawn = GetPawn();
if (pawn == )
return;

if (m_deviceController.IsValid() ==
{

m_deviceController = FCybSDK PluginModule::GetVirtualizerInputDevice();
if (m_deviceController.IsValid() == )
return;

TWeakObjectPtr<UVirtDevice> device = m_deviceController->GetDevice();

if (device == || !device->IsOpen())

return;

FVector movement = device->GetMovementVector() * MovementSpeedMultiplier;

FQuat localOrientation = device->GetPlayerOrientationQuaternion();

FQuat globalOrientation;

Virtualizer Unreal SDK Documentation




if (m_deviceController->IsDecoupled())

{

if (m_forwardDirection !=

{

m_forwardDirection->SetRelativeRotation(localOrientation);
globalOrientation = m_forwardDirection->GetComponentQuat();

}

else

{

globalOrientation localOrientation * pawn->GetActorQuat();

else

{

pawn->SetActorRotation(localOrientation);
globalOrientation = localOrientation;

FVector motionVector = globalOrientation * movement;

m_motionVector = motionVector;

if (motionVector.IsZero())
return;

if (m_characterMovementComponent !=

{

m_characterMovementComponent - >MoveSmooth (motionVector * 100.0f,
DeltaSeconds);

}

else if (m_movementComponent !=

{

m_movementComponent->AddInputVector (motionVector / 10.0f);
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pawn->SetActorLocation(pawn->GetActorLocation() + motionVector * 100.0f *
DeltaSeconds);

}
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